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            课程总览 

 
 
 
 
 
课程介绍 

 

                  本章将学习如何在SACS中创建结构模型 
 

 

目标用户 

 

本课程适用于以下目标群体： 
 

• 结构工程师 
 
 

 

课程目标 

                  完成此课程后，你将具备以下能力： 
 

• 在SACS中创建一个结构模型 
 
 

 

课程准备 
 

• 熟悉各种结构设计理论以及规范 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 



 

 

软件准备 

 

此课程内容依据以下软件版本编写: 
 

• SACS 11.0 Connect Edition  
 
 

 

课程内容 

 

                    此课程包含以下内容： 
 

• 创建导管架模型 
 

• 创建上部甲板结构模型 
 

• 创建载荷- Weight 方式 

• 创建环境载荷 

• 定义分析选项 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

                      导管架建模 
 
 
 
 
 
创建一个模型 

 

此节中，我们将学习创建一个用于静强度分析的导管架模型。导管架图纸见  

手册底部附录，其包含详细的结构布置以及单元尺寸信息。 
 

 练习: 开始建模



1. 首先在电脑上创建一个工作目录并命名为“Training project”，然

后在此工作目录下创建一个分目录” Structure modeling”。 

2. 双击桌面的SACS图标打开SACS 11.0软件, 首先进行软件整体设

置。点击SACS主界面左上角”settings”, 打开设置对话框。在

“units setting”中选择使用公制单位系统”Metric KN Force”。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 
3 在SACS主界面文件框”Files”下面address处将当前工作目录设置

为刚刚创建的”Training project\Structure Modeling”。 

 
 
 

4 点击SACS主界面左边模块列表处的”Modeler”，启动SACS GUI建模器

Precede。选择创建一个新的模型，点击OK。 
 
 
 
 
 
 
 
 
 
 
 
 

5 在出现的对话框中选择使用导管架建模向导以及公制单位，然后点击

OK。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 
 



 
 
创建导管架主结构 

 

此节中, 我们将定义导管架、桩以及隔水套管等主要模型结构单元。这些单

元具体参数尺寸可参考教材附录结构图纸。操作步骤如下： 

 

 练习: 定义导管架/桩以及隔水套管 


1 在结构设置向导“ Structure Definition dialog”中, 根据图纸101中

的尺寸参数来定义导管架，首先在” Elevations“ 菜单设置主要

水平层高度:  
 

• Working Point Elevation（工作点高度）: 4.0 m  
 

• Pile Connecting Elevation（桩腿连接点高度）: 3.0 m  
 

• Water Depth（水深）: 79.5 m  
 

• Mudline Elevation（泥面高度）: -79.5m  
 

• Generate Seastate Hydrodynamic Data: (勾选)  
 

• 其他水平层: -50.0, -21.0, 2.0, 15.3 (下甲板), 23.0m (主甲板)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

提示: 需要勾选中“Generate Seastate Hydrodynamic Data”选项, 程序才会自动生成水动力

计算相关参数，比如桩、wishbone单元的override设置. 

 
 
 



 
 
 

 2    点击 “Legs“进入导管架腿参数设置页面，按照如下步骤定义导管架

腿的相关参数， 

 

• Number of legs（腿的数量）: 4  
 

• Leg type（桩腿连接灌浆形式）: Ungrouted （非灌浆） 
 

• Leg spacing at working point（工作点平面腿间间距）: X1=15 m, 

Y1=10 m.  
 

• Row Labeling(行列编号): 使用默认值，需与图纸一致。 
 

• Pile/Leg Batter（桩腿倾斜度）: Row 1 (leg 1 和 leg 3) 在Y方向单

斜，batter值10; Row 2 (leg 2 and leg 4) X, Y方向双斜，batter值均

为10。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

3 点击 Conductors 进入隔水套管定义页面， 然后点击 Add/Edit 

Conductor Data 按钮添加隔水套管单元:  
 

• Number of Conductor Well Bays: 1  
 

• Top Conductor Elevation: 15.3 m  
 

• First conductor number: 5  
 

• Number of conductors in X direction: 2  
 

• Number of conductors in Y direction: 2  
 

• Coordinate of LL Corner: X= -4.5 m, Y= -1.0 m   
(左下conductor点的全局坐标. 见图102/104)  

 
• Distance Between Conductors: X与Y方向都为 2.0 m.  

 
• Disconnected elevations: -79.5 m, 3.0 m, 和 4.0 m.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

4 点击 Apply 按钮确认，生成的导管架框架模型（桩/腿以及隔水套

管）模型如下. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 点击左上菜单 File > Save As, 选择保存新文件并命名为 sacinp.dat_01, 

然后点击 OK。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

定义导管腿单元 （Leg） 属性 

 

此节练习中, 我们将定义刚刚使用向导创建的导管架腿单元的属性。 这些

单元的几何属性以及材料属性从附录图纸上可以找到，用户可以按照如下

步骤来定义。 

 

 练习: 定义导管架腿单元属性



1 在前处理建模器Precede菜单中, 选择 Property > Member Group，然

后单元属性定义对话框出现，如下所示： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

提示: 左边Undefined Group 框内显示所有赋予给已有单元 ，但是属性还

未定义的组名。一旦这些组的属性被定义好，他们将会被移到右

边Defined Groups中。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

2 在 Undefined Groups框内选择 LG1 并 点击 Add 按钮来定义LG1的截面

几何以及材料属性。 按照图纸LG1因为几何和材料参数变化需要分

成三段（3 segments）。 
 

在SACS中一个组包含多个segments时，可以在 Add Member Group 

对话框中, 按照下述步骤来进行定义:  
 

• 输入第一个Segment 的参数: D= 48.5 in, T= 1.75 in, Fy= 

34.5 kN/cm2, Segment Length = 1.0 m, 定义为充水杆件

“Flooded Member“ 
 

• 点击Add Segment 按钮 添加 Segment 2.  
 

• 输入  Segment 2 的参数: D=47.0 in, T=1.0 in, 

Fy=34.5 kN/cm2, 定义为充水杆“Flooded Member“ 
 

• Click the Add Segment button to add Segment 3.  
 

• 输入 Segment 3 的参数: D=48.5 in, T=1.75 in, Fy=34.5 

kN/cm2, Segment Length = 1.0 m, 定义为充水杆件

“Flooded Member“ 
 

• 点击 Apply 按钮完成定义。 

 

提示: 程序中输入参数的单位可以按照已有数据的单位制来做修改。下图

中圆管杆件的直径和厚度单位可以被手动修改成英制单位in。至于

此处加厚段segment的长度后面可以进行自动设计, 此处设置一个
初始值1.0m。下图显示LG1组的详细参数定义。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 重复上面步骤来定义LG2和LG3两个组的属性。具体参数参见附

录图纸 101。 
 
 
 
 
 
 
 

  
 



 
 

 

4 定义组 LG4, DL6, DL7, CON, PL* 和 Wishbone的单元; 其截面尺寸

参数可参考图纸 101。 
 

• LG4 = 48.5”x1.75”  
 

• DL6 = 42”x1.5”  
 

• DL7 = 42”x1.5”  
 

• CON = 30”x1” flooded  
 

• PL* = 42”x1.5”  
 

• W.B. = 30”x1” flooded  
 

5 定义上述非segmented的组, 从左边Undefined Group框内选择组名并点击 

Add 按钮，输入数据 并点击 Apply。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

上述所有组均为圆管截面单元，其几何和材料参数都可以在组的属

性对话框里面定义。 
 

6 选择 File > Save As, 保存为文件名 sacinp.dat_02, 然后点击 OK. 
 
 
 
 
 
 
 
 
 
 
 
  



 
 

 

已经定义的单元组信息保持在模型文件中，可以使用文本编辑器datagen打

开模型文件，使用文件格式查看已定义模型信息。 
 

-------------------------------------------------------------------------------------------------------------  
GRUP CON 76.200 2.540 20.007.72234.50 1 1.001.00 0.500F7.8490 

GRUP DL6 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP DL7 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP LG1 48.500 1.750 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG1 47.000 1.000 20.007.72234.50 1 1.001.00 0.500F7.8490 

GRUP LG1 48.500 1.750 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG2 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG2 119.38 2.540 20.007.72234.50 1 1.001.00 0.500F7.8490 

GRUP LG2 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG3 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG3 119.38 2.540 20.007.72234.50 1 1.001.00 0.500F7.8490 

GRUP LG3 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.00 

GRUP LG4 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.8490 

GRUP PL1 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP PL2 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP PL3 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP PL4 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP PL5 106.68 3.810 20.007.72234.50 1 1.001.00 0.500 7.8490 

GRUP W.B 76.200 2.540 20.007.72234.50 1 1.001.00 0.500F7.8490  
------------------------------------------------------------------------------------------------------------- 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



 
 

 

   创建导管架水平层 

 

此节中我们将创建导管架水平层框架，每一层的具体单元配置可参见附录

图纸。通过图纸可以来定义模型单元及其几何材料属性，步骤如下： 

 

 练习: 创建水平层 


1  打开模型文件 sacinp.dat_02 或者从上一步操作继续。



2 从precede中点击 Display > Plan， 然后选择 -79.5 高度层来创建此

泥面层结构框架。 此高度层的结构单元信息可参见图纸103, Plan 

@ EL (-) 79 500. 
  

3 点击 Display > Group Selection 在当前视图显示中选择去除桩以及 

Wishbone 单元。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4 通过step 3中操作，当前模型仅显示导管架腿以及隔水套管上的

节点。同时确保“Show Unattached Joints”选项没有被选中。 
 

我们将使用图纸中的尺寸信息来定义单元，使用 “Member Divide” 功

能来创建新的节点和单元。 
 
 
 



 
 

 

5 下一步添加连接导管腿的水平杆件单元。 选择 Member > Add，

打开添加单元对话框。 
 

6 在模型中点击节点 101L 和 102L 将其选择到添加单元对话框。然后 

输入 新生成的组的名字:  
 

• Group Label: H11  
 

然后, 点击 Apply 来生成新的单元。 
 
 
 
 
 
 
 
 
 
 
 
 

 

7 重复上面步骤以生成新的单元 101L-103L, 102L-04L and 103L-104L。 

 

提示: 下一步将使用“divide the members by ratio”来打断单元。 因为希望

得到的新节点都在单元中点上，我们可以使用dividing the member 

by ratio来得到新节点1100, 1101 以及 1102。 
 

8 为了生成节点1100, 使用 Member > Divide > Ratio. 

使用比例打断单元的对话框如下： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

9 点击单元 103L-104L，然后输入下列参数:  
 

• Member (Joint A - Joint B): 103L-104L  
 

• Ratio from Joint A: 0.5 m  
 

• New Joint Name: 1100  
 

• Use Next Available Name if Above Name Exists: (选中)  
 

其他选项使用默认值，然后点击Apply 去创建这些节点。 

 

提示: 我们将得到一个新的节点和两个新单元，原来的单元 103L-104L 将会

被新生成的两个新单元取代。 
 

10 重复此步骤来得到节点 1101 and 1102。 

 

提示: 下一步需要按照长度来打断单元。节点 1103 和 1104 可以通过按

照长度打断单元来得到，具体尺寸参见图纸 101。 
 

11 为了得到节点1103, 点击Member > Divide > Length，打开按长度打断

单元对话框。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

12 点击单元 101L-103L， 然后输入参数:  
 

• Member (Joint A - Joint B): 101L-103L  
 

• Length from Joint A: 11.35 m  
 

• New Joint Name: 1103  
 

• Use Next Available Name if Above Name Exists: (选中)  
 

其他选项使用默认值然后点击 Apply. 
 

13 使用同样步骤得到节点1004， 打断距离为4.0m。 

 

提示: 下一步是生成平面内的斜撑杆件。我们将通过连接节点1101-1100

来生成一个新的单元, 并将其组名定义为H12。 
 

14 使用 Member > Add 来连接节点1101-1102, 1102-1100, 1104-1100 

and 1101-1103以生成新单元, 并将其组名定义为H13。 
 

提示: 下一步我们将创建井口框架内单元。 可以使用按长度打断单元来

得到新节点 1105 和 1106，尺寸参见图纸 101。同样方法来得到节

点1103 和 1104. 
 

15 为了得到新节点1105, 使用  Member > Divide > 

Length。按长度打断单元的对话框如下， 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

16 点击选择单元 1001-1100， 然后输入如下参数:  
 

• Member (Joint A - Joint B): 1101-1100  
 

• Length from Joint A: 11.35 m  
 

• New Joint Name: 1105  
 

• Use Next Available Name if Above Name Exists: (选中)  
 

其他选项使用默认值然后点击 Apply。 
 

17 同样的方法添加节点 1006， 打断距离为4.0m。 
 

18 添加单元1104-1106 和 1103-1105, 组名使用H13.  
 

19 点击 Member > Divide > Length 来生成新节点 1107, 1108, 1109 and 

1110。 打断距离参见附录图纸。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

20 连接节点1107-1108 和 1109-1110 生成新单元，组名取为H14。 

 

提示: 下一步需要定义新生成单元组的属性。需要定义的组分别为H11, 

H12, H13 and H14; 相关单元的几何以及材料属性可以从图纸上找

到。SACS程序定义页面如下图。 

 

提示: SACS输入数据的单位可以被修改以满足图纸或其他原始文件格

式。下图显示程序中的单元直径厚度等输入参数的单位已经被改

成英制，以保持与图纸一致。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

提示: 检查输入单位是否正确。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

此节我们创建了第一个水平层结构单元。重复这些步骤可以依次创建其他水平

层结构，高度分别为-50.0m, -21.0m and 2.0m。 所有的结构单元信息都可以从

图纸102 和 103上找到。节点编号以及单元组名按照次序定义。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

创建隔水套管支撑面 

 

以水平高度层 -50为例，我们将创建一系列新的节点然后将他们连接成隔

水套管支架。这些单元将如下图所示添加在隔水套管周围。 

 

 练习: 创建隔水套管支撑面



1 按比例打断单元2107-2109, 2108-2110 来生成节点2111 和 2112。 
 

2 添加单元2107-2108, 2109-2110, 和 2111-2112，然后按比例从中

点打断以得到新的节点2113, 2114, 和 2115。 
 

3 连接单元 2113-2115 和 2115-2114。  
 

下一步定义隔水套管支撑面内单元的属性。 
 

4 选择 Property > Member Group 来定义格式套管支撑的属性，具体

节点单元信息如下。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 重复上述步骤来创建高度层 - 21.0 和 2.0的隔水套管支撑。  
 

6 文件另存为 SACINP.dat_03。  
 
 
 
 
  



 
 

 

创建导管架各个Row上的斜撑单元 

 

从附录图纸可以看到各个侧面的斜撑分布情况，下一部分将展示如何在模

型中创建这些单元。 

 

 练习: 创建导管架Rows上的斜撑



1 在Precede中打开模型文件 sacinp.dat_03，点击 Display > Face, 然后

选择 Row A。 
 

2 使用 Display > Group Selections 将桩以及wishbone单元从当前

视图中去除。  
 

3 点击工具栏上的“ J” 和 “G” 图标 ，显示已定义节点以及组的名字。  
 

4 定义高度层-79.5m和-50.0m之间的X brace。 
 

5 选择 Member > X-Brace， 添加 X-brace 的对话框如下。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

6 点击选择节点 101L, 202L, 201L, and 102L，他们会自动出现在生成单

元对话框(注意是交叉选择) ，然后输入如下数据:  
 

• Center Joint: 101X  
 

• End Joint of Thru Member: 101L  
 

• Other end of thru Member: 202L  
 

• End on non-thru Member: 201L  
 

• Other end of this Member: 102L  
 

• Group of thru Member: BR1  
 

• Group of non-thru Member: BR2  
 

• K Factor (out of plane): 0.9  
 

7 点击 Apply.  

 

提示: 下一步同样方法定义高度层-50.0m 和 - 21.0m之间的X-brace。 

 
 

8 选择 Member > X-Brace，出现 添加 X-brace 对话框如下。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

9 点击节点202L, 301L, 302L, and 201L， 他们会自动显示在对话框中 (注

意是交叉选择)， 然后输入如下参数:  
 

• 中心点: 201X  
 

• 贯穿单元端点: 202L  
 

• 贯穿单元另一端点: 301L  
 

• 非贯穿单元端点: 302L  
 

• 非贯穿单元另一端点: 201L 
 

• 贯穿单元的组名: BR3  
 

• 非贯穿: BR4  
 

• K Factor (out of plane): 0.9  
 

10 点击 Apply.  
 

11 重复步骤 8 and 9 来生成高度层-21.0 m 和 2.0 m之间的X-brace。新的

中心点命名为301X; 贯穿单元组名取BR5， 其他单元组名为BR6。 
 

中心点101X, 201X and 301X 的位置由程序自动计算。 
 

12 重复步骤1 to 11 来创建Row B，Row 1和Row 2的X-braces; 使用相同

的组名， 中间节点的开始编号Row B为 102X, Row 1 为103X , Row 2 

为104X。 
 

13 定义X-brace 单元组的属性。 BR1, BR3, 和 BR5 为包含segments的贯穿

单元, BR2, BR4, and BR6 为非贯穿单元。 所有单元的信息参见图纸 

101。  
 

14 保存模型并命名为sacinp.dat_04.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

                      甲板组块 
 
 
 
 
 

创建上部甲板组块模型 

 

两层甲板的单元分布参见图纸，本节将练习如何在模型中创建这些单元。 

 

 练习: 创建甲板框架



1 为了创建下层甲板(高度 +15.30m) 选择 File > Structure Definition 然后

点击 Deck Girders 菜单，然后选择点击Add/Edit Deck Girder Data 按

钮。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 输入如下参数:  
 

• Deck elevation: 15.30  
 
 
 
 
 



 
 

 

• Lower Y Deck Distance (YL): 4.0 m  
 

• Lower Y Deck Distance (YU): 4.0 m  
 

• Add Main Deck Girders (DKG): (选中)  
 

• Add Bracing around Perimeter of the deck: (选中)  
 

3 点击 Apply 完成上述定义。  
 

4 为了定义主甲板层(高度 +23.0m), 再次点击Add/Edit Deck Girder 

Data 按钮。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 输入如下结构参数:  
 

• Deck Elevation: 23.00  
 

• Right X Deck Distance (XR): 5.0 m  
 

• Lower Y Deck Distance (YL): 4.0 m  
 

• Lower Y Deck Distance (YU): 4.0 m  
 

• Add Main Deck Girders (DKG): (选中)  
 

• Add Bracing around Perimeter of the deck: (选中)  
 

6 点击 OK 完成上述定义并关闭对话框。 
 
 
 
 

 



 
 

 

7 选择 Display > Plan  选择 15.3 高度层， 然后使用 Display > Labeling > 

Special 并选择关闭 “Show jacket rows” 以得到放大视图。从快捷工具

栏选择打开“Joint and Group Label” 以显示节点和单元组编号。 
 

8 根据图纸15.3这一层有两种不同的非圆管型材单元，使用Member > 

Details/Modify将这些单元的组名分别修改为W01 和 W02。 
 

9 使用单元打断功能 “Member divide” 来创建所需的新节点，所生成的

新的节点和单元的编号按照相应规则定义。具体单元尺寸可以从图

纸202中读取。 
 

此步建模中所需的操作命令如下:  
 

• Member > Divide > Distance  
 

• Member > Divide > Ratio  
 

• Member > Divide > Perpendicular  
 

10 新生成的节点编号从 7100开始指定，打断过程中所需的distances和 

ratios 值可从图纸中找到。隔水套管使用虚拟单元(dummy members)

与甲板单元相连，方法与下部基础平面类似。 
 

11 重复第7到10步 来创建主甲板层EL 23.00，具体单元信息见图纸。 
 

12 定义单元组W01属性，使用程序自带截面库the AISC 9th edition 中的

如下截面类型:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

13 在 Add Member Group 对话框中, 点击Section Label和 Edit旁边的 (...) 

按钮 进入程序自带的截面库。 
 

14 在Select Section 对话框中, 首先选择Library section type为Wide 

Flange，然后在section list中选择W24X162并点击Ok。 
 

15 在Add Member Group 对话框中, 按照上图进行参数设置.  
 

16 重复上图步骤来定义单元组W02的属性（W24X131）。 
 

定义好的甲板单元组在datagen中显示如下: 
 

-------------------------------------------------------------------------------------------------------------  
GRUP W01 W24X162 20.007.72224.80 1 1.001.00 7.8490 

GRUP W02 W24X131 20.007.72224.80 1 1.001.00 7.8490  
-------------------------------------------------------------------------------------------------------------  

17 保存模型并命名为sacinp.dat_05. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

定义设计参数 

 

在这一节中, 我们将定义如下设计参数: 
 

• 节点连接设置 
 

• 甲板单元偏移设置  
 

• 单元后处理校核选项 
 

 

节点连接设计 

 

在这一节中, 我们将尝试修改模型以保持与图纸完全一致。当前模型中, 所有

单元都是从一个节点连接到另外一个节点。下面我们将通过单元偏移设置来

将支杆偏移到主杆表面，同时在多支杆连接处设置GAP值。 

 

 练习: 创建一个节点连接 


1 点击 Display > Group Selections 菜单，在对话框中使用“ exclude 

group”在当前视图中移除 BR1-BR6, H11-H43, PL1-PL5, W01, W02, 

CON, DL6-DL7, 以及 W.B这些组。 关闭 “Show unattached joints” 选项

并点击 Apply.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 选择 Joint > Connection > Automatic Design. 
 
 



 
 

 

出现的 “Automatic Joint Design” 对话框如下 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 在 “Automatic Joint Design” 对话框中, 点击 General页面。 
 

4 输入如下参数:  
 

• Offset braces to outside of chord: (勾选)  
 

• Gapping option: Move Brace  
 

• Brace Move: Along Chord  
 

• Gap: 5 cm  
 

• Gap size option:  Minimum only  
 

• Use existing offsets if gap criteria is met: (勾选)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

5 在 Automatic Joint Design 对话框中, 点击选择 Can/Chord 页面。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

6 输入如下参数:  
 

• Update Segmented Groups Can Lengths: (勾选)  
 

• Can Length Option: API minimum requirements  
 

• Increase Joint Can Lengths Only: (勾选)  
 

7 点击 Apply确认设置，生成节点设计后的模型。 

 

提示: 导管架腿单元的segment长度 由程序自动计算并在模型中更新，每个

单元两端的偏移值由程序自动计算完成。 
 

8 现在开始创建连接隔水套管和平面内杆件的虚拟单元（dummy 

members）。隔水套管和主结构单元的连接如下图所示。.  
 

• DUM = 12.75 x .375  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

9 重复上述步骤来创建高度层-21.0, 2.0 和 15.3上的隔水套管连接。  
 

10 保存模型并命名为 sacinp.dat_06。  
 
                           最终导管架腿上加厚段长度更新之后的模型在datagen中显示如下: 
 

         -------------------------------------------------------------------------------------------------------------  
GRUP LG1 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84902.10 

GRUP LG1 119.38 2.540 20.007.72224.80 1 1.001.00 0.500F7.8490 

GRUP LG1 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.76 

GRUP LG2 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84902.16 

GRUP LG2 119.38 2.540 20.007.72224.80 1 1.001.00 0.500F7.8490 

GRUP LG2 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.63 

GRUP LG3 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84902.33 

GRUP LG3 119.38 2.540 20.007.72224.80 1 1.001.00 0.500F7.8490 

GRUP LG3 123.19 4.445 20.007.72234.50 1 1.001.00 0.500F7.84901.60 

GRUP LG4 123.19 4.445 20.007.72234.50 1 1.001.00 0.500 7.8490  
        ------------------------------------------------------------------------------------------------------------- 

 
 
 
 
 
 
 
 
 



 

 

定义甲板单元偏移 

 

通常我们都希望所有甲板单元端部在同一高度对齐，下面将介绍如何通过

offset将所有单元顶端对齐。同样的方法也能将所有单元设置为底对齐，

也能分别对单元两端的节点设置偏移值。 

 

 练习: 定义甲板单元的偏移



1 点击 Display > Plan 然后选择高度15.3m，使用”Exclude group”在当前

视图中移除 W.B 和 CON 这两个组。  
 

2 点击 Member > Offsets… 按住鼠标左键并框选当前视图中的所有

单元 (被选中的单元将会被以红色高亮显示)。 
 

3 进入 “Member Offsets” 对话框, 输入如下参数:  
 

• Offset Type: Top of Steel  
 

4 点击 Apply 应用偏移设置。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

提示:  使用“top of steel”方式来设置单元偏移之前，需要先定义好单元

组的属性。 
 

5 重复步骤 1到4 以定义主甲板层EL 23.00m上单元的偏移值。 
 

6 保存模型并命名为sacinp.dat_06。 
 
 
 
 
 



Defining the Design Parameters 
 

 

定义单元有效屈曲长度 

 

单元有效屈曲长度系数的默认值是1.0。如果单元在中间某个点打断而在这

个位置没有相应的抗弯曲支撑约束，则需要修正相应单元的Ky，Kz或者

Ly，Lz。  
 

 练习: 定义单元有效屈曲长度



1 先定义水平层内杆件的 Ky/Ly, 选择 Property > K Factor > Ky 然后按如

下所示修正Ky系数:  
 

• 水平层 Z = -79.50 m内组名为H11的单元 
 

• 水平层 Z = -50.0 m内组名为H21的单元 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

2 选择 Property > Effective Length > Ly 修正Ky 如下:  
 

• 水平层 Z = -21.0 m内组名为H31的单元 
 

• 水平层 Z = 2.0 m 内组名为H41的单元 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 保存模型并命名为 sacinp.dat_06. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

             结构载荷施加 - weight 
 
 
 

 

设计载荷包括： 

 

设备载荷 

 

设定两层甲板总共四个设备，设备具体位置见图纸 201。设备重量信息如

下表所示： 
 

编号 设备 ID 重量 重心高* 
    

1 SKID1 1112.05 kN 3.0 m 
    

2 SKID2 667.23 kN 2.5 m 
    

3 SKID3 444.82 kN 2.0 m 
    

4 SKID4 155.587 kN 4.0 m 
    

 

*重心高度为坐标轴Z向, 相对于设备底面的高度。 

 

甲板均布载荷 
 

• 主甲板均布面压: 0.75kN/m2  

• 下甲板均布面压: 0.5kN/m2  
 

甲板活载荷 
 

• 主甲板活载荷: 5.0kN/m2  

• 下甲板活载荷: 2.5kN/m2  
 

附属构件载荷: 
 

                    导管架附属结构的重量也应该包含在模型中。 
 
 
 
 
 
 
 

 



 
 

 

环境载荷: 
 

• 静水深: 79.5m  
 

• 高潮位: 1.5m  
 

• 海生物厚度:  
 

 Distance from  Thickness (cm) Dry density (T/m3) 
 

 Mudline (m)       
 

         
 

 0-60    2.5  1.4 
 

         
 

 60-79.5    5.0  1.4 
 

         
 

• 海流速度:       
 

        
 

 Distance from    Velocity (m/s) 
 

 

Mudline (m) 
     

 

  1 Year  100 Years 
 

        
 

 Bottom  0.514  0.514 
 

        
 

 Surface  1.029  1.081 
 

         
 

• 风速:       
 

       
 

    Velocity at 10m (m/s)   
 

        
 

 1 Year    100 Years 
 

        
 

 25.72    45.17 
 

         
 

• 波浪参数:       
 

       
 

 Wave Height  Period (sec)  Wave Height Period (sec) 
 

 (m)     (m)   
 

        
 

 1 Year    100 Years 
 

         
 

 6.10   12.00  12.19  15.0 
 

         
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

 波浪散布图（用于波浪谱疲劳计算） 

 

Table 1: 0.0 方向 
 

Dominant  Significant Wave Height (M) 
Period (SECS)     

     

  0.0 - 0.6 0.6 - 1.4 1.4 - 2.6 
     

1.0 - 2.0  0.15 0.10 0.10 
     

2.0 - 4.0  0.10 0.19 0.11 
     

4.0 - 6.0  0.05 0.08 0.05 
     

6.0 - 10.0  0.02 0.03 0.02 
    

 
Table 2: 45.0 方向   
   

Dominant  Significant Wave Height (M) 
Period (SECS)     

     

  0.0 - 0.6 0.6 - 1.4 1.4 - 2.6 
     

1.0 - 2.0  0.10 0.13 0.08 
     

2.0 - 4.0  0.15 0.13 0.10 
     

4.0 - 6.0  0.08 0.08 0.07 
     

6.0 - 10.0  0.03 0.02 0.03 
     

 

 

Table 3: 90.0方向 
 

Dominant  Significant Wave Height (M) 
Period (SECS)     

     

  0.0 - 0.6 0.6 - 1.4 1.4 - 2.6 
     

1.0 - 2.0  0.13 0.10 0.08 
     

2.0 - 4.0  0.13 0.15 0.10 
     

4.0 - 6.0  0.06 0.09 0.08 
     

6.0 - 10.0  0.03 0.03 0.02 
     

 
 
 
 
 



 
 

 

地震烈度（用于地震校核）: 
 

• 最大地面水平加速度: 0.15g  
 

• 响应谱: 使用API B spectrum 曲线 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

结构加载 (使用Weight 功能) 

 

在SACS中, 可以按照如下方式来对结构施加载荷: 
 

• Surface Loads （面内均布载荷） 
 

• Equipment Loads （设备载荷） 
 

• Appurtenant Structure Loads （附属构件载荷） 
 

• Inertia Loading （惯性载荷） 
 

• Environmental Loading （环境载荷，包含wind, wave, current, dead load） 
 

 

面内均布载荷 
 

在SACS里面, 面内均布载荷可以通过下面两步来定义: 
 

• 定义一个Surface: 使用Weight > Surface Definition 命令。  
 

• 定义 Surface Weight: 使用 Weight > Surface Weight 命令, 将面压载荷施

加在前一步定义的 surface上。  
 

 练习: 定义甲板均布重量载荷以及活载荷 



提示: 对于本手册中的例子, 我们将在模型上施加如下surface loads: 


• 甲板均布重量载荷:  
 

• 主甲板: 0.75 kN/m2  

• 下甲板: 0.5 kN/m2   
• 活载荷:  

 

• 主甲板: 5.0 kN/m2  

• 下甲板: 2.5 kN/m2  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

1 首先创建一个定义下甲板均布载荷所需的surface, 选择Weight > 

Surface Definition 然后输入如下参数:  
 

• Surface ID: CELLWT1  
 

• 1st Joint (origin): 71BD  
 

• 2nd Joint (local X): 71ED  
 

• 3rd Joint (local Y): 74BD  
 

• Tolerance: 0.5 m  
 

• Load Distribution Direction: Members in the local Y direction  
 

• Boundary Joints: CTRL 键并选择 71BD, 71ED, 和 74BD 节点。  
 

2 点击 Apply 来创建此 surface。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 下面创建主甲板 surface 以定义主甲板均布载荷, 选择 Weight > 

Surface Definition 然后设置如下参数:  
 

• Surface ID: MAINWT1  
 

• 1st Joint (origin): 81BD  
 

• 2nd Joint (local X): 81FD  
 

• 3rd Joint (local Y): 84BD  
 

• Tolerance: 0.5 m  
 

• Load Distribution Direction: Members in the local Y direction  
 

• Boundary Joints: 按住 CTRL 键然后选择81BD, 81FD和84BD节点。  
 
 
 
 
 



 
 

 

4 点击 Apply 来创建此 surface。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 给定义好的surface施加面压以生成甲板均布载荷，这里重量组的名

字（weight group name）使用 AREA 。 选择 Weight > Surface Weight 

并按照以下参数进行设置:  
 

• Weight Group: AREA  
 

• Weight ID: AREAWT  
 

• Pressure: 0.5 kN/m2 (下甲板)  
 

然后, 选择下甲板surface ID “CELLWT1” 并移至右侧 Included Surface 

IDs 框内。 
 

6 点击 Apply。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7 下面定义一个0.75 kN/m2 的面压于主甲板，将surface “MAINWT1”移

至右侧 Included Surface IDs 窗口。 再次点击 Apply 完成载荷施加。  



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8 使用上述步骤5-7中的surface weight功能来定义甲板平面的活载荷。重

量组名为LIVE。  主甲板活载荷Weight ID为MAINLIVE，面压大小5.0 

kN/m2， 下甲板Weight ID为 CELLLIVE， 面压大小为2.5 kN/m2。  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

新添加的surface以及surface weight 信息在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

SURFID CELLWT1 LY 71BD 71ED 74BD 0.500 

SURFDR 71BD 71ED 74ED 74BD   

SURFID MAINWT1 LY 81BD 81FD 84BD 0.152 

SURFDR 81BD 81FD 84FD 84BD   

SURFWTAREA 0.500AREAWT 1.001.001.00CELLWT1 

SURFWTAREA 0.750AREAWT 1.001.001.00MAINWT1 

SURFWTLIVE 2.500CELLLIVE 1.001.001.00CELLWT1 

SURFWTLIVE 5.000MAINLIVE 1.001.001.00MAINWT1  
------------------------------------------------------------------------------------------------------------- 

 
 
 



 

 

设备载荷 

 

在SACS中，设备载荷可通过Weight > Footprint Weight 命令来添加。使用

此命令，用户可以输入如下参数来定义设备模型载荷： 
 

• Weight of Equipment （设备载荷重量） 
 

• Footprint Center   （设备底面投影中心） 
 

• Weight Location   （重心位置） 
 

• Footprint Size （投影面尺寸） 
 

• Footprint Type （底面连接类型） 
 

 练习: 定义设备载荷



提示:  对于当前培训例子，设定结构上一共有四个设备载荷，其位置参

见图纸201。四个设备的重量信息如下表所示。

 
No. Equipment Weight Weight 

 ID  Location (Z) 
    

1 SKID1 1112.05 kN 3.0 m 
    

2 SKID2 667.23 kN 2.5 m 
    

3 SKID3 444.82 kN 2.0 m 
    

4 SKID4 155.587 kN 4.0 m 
     

1 首先定义第一个设备Skid1, 选择 Weight > Footprint Weight 然后输入

如下参数:  
 

• Weight Group: EQPT  
 

• Footprint ID: SKID1  
 

• Weight: 1112.05 kN  
 

• Footprint Center (X, Y, Z): 5.0 m, 2.0 m, 23.0 m  
 

• Weight Location (X, Y, Z): 0.0 m, 0.0 m, 3.0 m  
 

• Type of Weight Location: Relative to the Footprint Center  
 

• Length (footprint): 6.0 m  
 

• Width (footprint): 3.0 m  
 

• Footprint Type: Skid  
 

• Number of Longitudinal Skid Beams (X direction): 2  
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 点击 Apply 后所定义的载荷信息将显示在出现的窗口中，确认

无误后点击Keep保存当前定义的设备载荷信息。 
 

3 继续留在Weight Footprint Data对话框来定义Skid2, 输入如下参数:  
 

• Weight Group: EQPT  
 

• Footprint ID: SKID2  
 

• Weight: 667.23 kN  
 

• Footprint Center (X, Y, Z): -5.0 m, -7.0 m, 23.0 m  
 

• Weight Location (X, Y, Z): 0.0 m, 0.0 m, 2.5 m  
 

• Type of Weight Location: Relative to the Footprint Center  
 

• Length (footprint): 6.0 m  
 

• Width (footprint): 2.5 m  
 

• Footprint Type: Skid  
 

• Number of Longitudinal Skid Beams (X direction): 2  
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 继续在当前Weight Footprint Data对话框来定义Skid4, 输入如下参数:  
 

• Weight Group: EQPT  
 

• Footprint ID: SKID4  
 

• Weight: 155.587 kN  
 

• Footprint Center (X, Y, Z): 10.0 m, 6.0 m, 23.0 m  
 

• Weight Location (X, Y, Z): 0.0 m, 0.0 m, 4.0 m  
 

• Type of Weight Location: Relative to the Footprint Center  
 

• Length (footprint): 6.0 m  
 

• Width (footprint): 3.0 m  
 

• Footprint Type: Skid  
 

• Number of Longitudinal Skid Beams (X direction): 3  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 继续在当前Weight Footprint Data对话框定义Skid3, 输入如下参数:  
 

• Weight Group: EQPT  
 

• Footprint ID: SKID3  
 

• Weight: 444.82 kN  
 

• Footprint Center (X, Y, Z): 5.0 m, 0.0 m, 15.3 m  
 

• Weight Location (X, Y, Z): 0.0 m, 0.0 m, 2.0 m  
 

• Type of Weight Location: Relative to the Footprint Center  
 

• Length (footprint): 6.0 m  
 

• Width (footprint): 2.5 m  
 

• Footprint Type: Skid  
 

• Number of Longitudinal Skid Beams (X direction): 2  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

定义好的 设备重量组信息在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

WGTFP EQPT1112.05SKID1 5.000 2.00023.000R 3.0006.0003.000 2 

WGTFP2 1.001.001.00.152L   

WGTFP EQPT667.230SKID2 -5.000-7.00023.000R 2.5006.0002.500 2 

WGTFP2 1.001.001.00.152L   

WGTFP EQPT155.587SKID4 10.000 6.00023.000R 4.0006.0003.000 3 

WGTFP2 1.001.001.00.152L   

WGTFP EQPT444.820SKID3 5.000   15.300R 2.0006.0002.500 2 

WGTFP2 1.001.001.00.152L   
 

------------------------------------------------------------------------------------------------------------- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

附属构件载荷 

 

在SACS中, 附属构件的载荷可以使用单元载荷、节点载荷或者阳极块载荷

定义，分别见菜单中的Weight > Member Weight, Weight > Joint Weight和

Weight > Anode Weight 命令。 

 

 练习: 定义导管架以及甲板上的各种重量



1 首先创建甲板上的走道, 选择 Weight > Member Weight 然后按住

control 键选择甲板靠东边的所有单元， 然后输入如下参数: 
 

• Weight Group: MISC  
 

• Weight ID: WALKWAY  
 

• Weight Category: Distributed  
 

• Coordinate System: Global  
 

• Initial Weight Value: 2.773 kN/m  
 

• Final Weight Value: 2.773 kN/m  
 

• Load Direction Factors: (使用默认值)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 点击 Apply 并应用设置。 
 
 
 

 



 
 

 

3 下一步定义起重机重量, 选择 Weight > Joint Weight 然后选择节点 

804L 并输入下述参数:  
 

• Weight Group: MISC  
 

• Weight ID: CRANEWT  
 

• Joints: 804L  
 

• Weight: 88.964kN  
 

• Load Direction Factors: (使用默认值)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 点击 Apply, 然后选择 Keep保存设置。 
 

5 下一步定义Firewall防火墙, 选择 Weight > Member weight。 
 

6 鼠标选择如下单元 703L-74BD, 7102-7103, 7106-7107， 然后输入如

下参数： 
 

• Weight Group: MISC  
 

• Weight ID: FIREWALL  
 

• Weight Category: Concentrated  
 

• Coordinate System: Global  
 

• Concentrated Weight: 15.0 kN  
 

• Distance to Concentrated Weight: 1.5 m  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

• Load direction factors: (使用默认值)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7 点击 Apply, 然后 Keep保存。 
 

8 下面定义导管架上吊耳Padeye的重量, 选择 Weight > Joint Weight。 
 

9 点击选择节点501L, 502L, 503L 和 504L，然后输入如下参数:  
 

• Weight Group: LPAD  
 

• Weight ID: PADEYE  
 

• Weight: 2.0 kN  
 

• Include Buoyancy and Wave Load: (选中)  
 

• Density: 7.849 tonne/m3  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10 点击Apply, 然后选择Keep保存。 
 
 
 

 



 
 

 

11 下面定义靠船件 (EL 2.0m)处的走道, 选择 Weight > Member Weight  

然后选择EL 2.0 平面的所有杆件（除去隔水套管支架杆件）然后输入

如下参数： 
 

• Group ID: WKWY  
 

• Weight ID: WLKWAY  
 

• Weight Category: Distributed  
 

• Coordinate System: Global  
 

• Initial Weight Value: 1.5k N/m  
 

• Final Weight Value: 1.5 kN/m  
 

• Load Direction Factors: (使用默认参数)  
 

• Include Buoyancy and Wave Load: (选中)  
 

• Density: 1.5 tonne/m3  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12 点击 Apply, 然后选择Keep保存。 
 
 
 
 
 
 
 
 
 
 



 
 

 

13 下面定义阳极块重量, 选择 Display > Volumes 并选择类型为

Volumes to include。 
 

14 选择节点 101L 作为 Z坐标范围的最小值， 然后选择节点301X 来得到

Z坐标范围的最大值。 然后点击Apply。  
 

提示:  通过上述步骤仅显示含有阳极块的部分结构。 
 

15 选择 Display > Group selection 在模型中移除 组名为PL1-PL5, W.B, 

CON, H13-H14, H23-H24 以及 H32-H33的这些单元。其中包含 

wishbone, 隔水套管, 桩, 以及视图中的一些水平单元。 
 

16 选择 Weight > Anode Weight 然后拖动窗口选择当前视图中的

所有单元， 然后输入如下参数:  
 

• Weight Group: ANOD  
 

• Anode ID: Anode  
 

• Anode Weight: 2.5 kN  
 

• # Anodes per Member: 2  
 

• Anodes are Equally Spaced: (选中)  
 

• Include Buoyancy and Wave Load: (选中)  
 

• Density: 2.70 tonne/m3  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

17 点击Apply, 然后选择 Keep保存。 
 

18 保存模型并命名为Sacinp.dat_07。 
 
 
 
 
 
 
 



 
 

 

定义的导管架重量信息在datagen中打开显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

WGTMEMANOD101L101X 6.040 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTMEMANOD101L101X 12.080 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTMEMANOD103L102X 6.040 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTMEMANOD103L102X 12.080 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

… 
 

… 
 

WGTMEMANOD103L103X 6.599 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTMEMANOD103L103X 13.198 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTMEMANOD104L104X 6.619 2.500 1.001.001.00GLOBCONC 2.700ANODE 
 

WGTJT LPAD 2.000PADEYE 501L 7.849 1.0001.0001.000 
 

WGTJT LPAD 2.000PADEYE 502L 7.849 1.0001.0001.000 
 

WGTJT LPAD 2.000PADEYE 503L 7.849 1.0001.0001.000 
 

WGTJT LPAD 2.000PADEYE 504L 7.849 1.0001.0001.000 
 

WGTMEMWKWY4102404L 1.500 1.5001.001.001.00GLOBUNIF 1.500WLKWAY 

WGTMEMWKWY402L4102 1.500 1.5001.001.001.00GLOBUNIF 1.500WLKWAY 

WGTMEMWKWY4101402L 1.500 1.5001.001.001.00GLOBUNIF 1.500WLKWAY 
 

------------------------------------------------------------------------------------------------------------- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

惯性力 

 

在SACS中,  用户可以通过已定义的甲板重量组来生成惯性力载荷, 所需

的步骤如下 : 
 

• 定义加速度的中心: 使用Weight > Center of Roll 命令。  
 

• 定义加速度大小： 使用Environmental > Loading > Weight 命令 
 

 练习: 创建甲板载荷



1 首先定义角加速度转动中心, 选择 Weight > Center of Roll, 然后按照如

下信息输入转动中心位置:  
 

Center ID X Coordinate Y Coordinate Z Coordinate 
    

CEN1 0.0 m 0.0 m 0.0 m 
    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 点击 Apply应用设置。 
 

3 给重量组施加加速度, 选择 Environmental > Loading > Weight。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

4 首先勾选 Acceleration 选项，为要创建的四个载荷工况AREA, EQPT, 

LIVE和MISC 施加一个Z方向大小为1.0g的加速度。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 在每个新定义的载荷工况中, 点击选中 Include weight group选

项，分别选中对应的重量组AREA, EQPT, LIVE 和 MISC到右侧，生成

载荷工况AREA, EQPT, LIVE 和 MISC。 
 
 

提示: EQPT, LIVE, AREA和 MISC 这些载荷工况的生成需要同时定义重量组

并施加加速度。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

如下图片显示为载荷工况AREA 定义重量组。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7 保存模型并命名为 Sacinp.dat_08  
 

下部导管架结构上的重量组也会包含在环境载荷工况中，以考虑它们可

能承受的DEAD load和波浪力。  
 

定义好的甲板惯性力载荷在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

LOADCNAREA   

INCWGT AREA   

ACCEL 1.00000 N CEN1 

LOADCNEQPT   

INCWGT EQPT   

ACCEL 1.00000 N CEN1 

LOADCNLIVE   

INCWGT LIVE   

ACCEL 1.00000 N CEN1 

LOADCNMISC   

INCWGT MISC   

ACCEL 1.00000 N CEN1 
 

------------------------------------------------------------------------------------------------------------- 
 
 



 
 

 
 

环境载荷  
 

在SACS中, 可使用如下命令来定义环境载荷以及相关参数: 
 

• 定 义 拖 曳 力 以 及 惯 性 力 系 数 : 使 用 Environmental > Global 

Parameters > Drag/Mass Coefficient 命令。  
 

• 定义海生物: 使用 Environmental > Global Parameters > Marine Growth 命

令。  
 

• 修正单元水动力计算参数 : 使用  Environmental > Global 

Parameters > Member Group Overrides 命令。  
 

• 定义波浪, 海流, 风, 以及 重力/浮力载荷: 使用 Environment > Loading > 

Seastate 命令。  
 

 练习: 定义环境载荷 


1 定义拖曳力和惯性力系数 , 选择  Environmental > Global 

Parameters > Drag/Mass Coefficient 来定义  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 对于粗糙杆件和光滑杆件采取同样的设置 Cd=0.6，Cm=1.2。 

所有单元使用统一的Cd，Cm值。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

3 定义海生物厚度, 选择 Environment > Global Parameters > Marine 

growth 并输入如下参数:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

海生物定义命令在datagen中打开显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

MGROV     

MGROV 0.000 60.000 2.500 1.400 

MGROV 60.000 79.500 5.000 1.400 
 

------------------------------------------------------------------------------------------------------------ 
 

4 对于单元水动力参数修正, 选择 Environment > Global Parameters > 

Member Group Overrides命令。 
 

5 修正组名为LG1-LG3的导管架腿单元，需要考虑连接到腿上的附属

构件比如立管，J-tube等所受的环境载荷。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

6 在对话框中选中导管架腿单元组LG1-LG3 , 如下图所示。从图中可以看

到，因为模型中未显式模拟连接到腿上的立管等附属构件，所以与之

连接的导管架腿单元的Cd，Cm被放大1.5倍 以考虑载荷增加的部分。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

水动力修正的命令在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

GRPOV   

GRPOV LG1 F 1.501.501.501.50 

GRPOV LG1 F 1.501.501.501.50 

GRPOV LG1 F 1.501.501.501.50 

GRPOV LG2 F 1.501.501.501.50 

GRPOV LG2 F 1.501.501.501.50 

GRPOV LG2 F 1.501.501.501.50 

GRPOV LG3 F 1.501.501.501.50 

GRPOV LG3 F 1.501.501.501.50 

GRPOV LG3 F 1.501.501.501.50 

GRPOVAL PL1NN 0.001 0.001 0.001 

GRPOVAL PL2NN 0.001 0.001 0.001 

GRPOVAL PL3NN 0.001 0.001 0.001 

GRPOVAL PL4NN 0.001 0.001 0.001 

GRPOV W.BNF 0.001 0.001 0.001 0.001 0.001 
 

------------------------------------------------------------------------------------------------------------- 
 

静强度校核包含的正常操作工况(考虑三个环境载荷方向: 0.00, 

45.00, 90.00)， 载荷工况名分别为P000, P045和 P090。 
 

导管架上的重量组ANOD和 WKWY 应该包含在上面三个环境载荷工

况中，使用Environment > Loading > Weight > Include Weight Group来

考虑这些重量组所受的重力、浮力以及波浪海流力。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

7 选择 Environment > Loading > Seastate 来定义波浪, 流，风以及 重力/浮

力的参数大小。这些参数能够从设计输入中找到，下图显示载荷P000

的详细定义。  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

定义好的三个操作工况载荷在datagen中打开后显示如下: 
 

-------------------------------------------------------------------------------------------------------------  
LOADCNP000      

INCWGT ANODWKWY    

WAVE       

WAVE1.00STRE 6.10 12.00 0.00 D 20.00 18MS10 1 

WIND       

WIND D 25.720  0.00 AP08   

CURR       

CURR 0.000 0.514 0.000 -5.000BC LN 

CURR 79.500 1.029     

DEAD       

DEAD -Z  M BML   

LOADCNP045      

INCWGT ANODWKWY    

WAVE       

WAVE1.00STRE 6.10 12.00 45.00 D 20.00 18MS10 1 

WIND       

WIND D 25.720  45.00 AP08   

CURR       

CURR 0.000 0.514 45.000 -5.000BC LN 

CURR 79.500 1.029 45.000    

DEAD       

DEAD -Z  M BML   

LOADCNP090      

INCWGT ANODWKWY    

WAVE       

WAVE1.00STRE 6.10 12.00 90.00 D 20.00 18MS10 1 

WIND       

WIND D 25.720  90.00 AP08   

CURR       

CURR 0.000 0.514 90.000 -5.000BC LN 

CURR 79.500 1.029 90.000    

DEAD       

DEAD -Z  M BML    
------------------------------------------------------------------------------------------------------------- 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

极端风暴工况(考虑三个方向: 0.00, 45.00, 90.00)的载荷工况名字分别为 

S000, S045 和 S090。 

 

极端风暴载荷工况的定义与正常操作工况类似, 但其使用100年一遇的环境

标准去生成载荷工况。导管架重量组ANOD和 WKWY也应该包含在这三个载
荷工况中，每个工况的水深需要考虑潮位进行修正。详细的参数输入可以

按照如下所示进行定义。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

定义好的三个极端工况在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

LOADCNS000      

INCWGT ANODWKWY     

WAVE       

WAVE1.00STRE 12.19 81.00 15.00  D 20.00 18MS10 1 

WIND       

WIND D 45.170 0.00 AP08    

CURR       

CURR 0.000 0.514  0.000  -5.000BC LN 

CURR 81.000 1.801     

DEAD       

DEAD -Z 81.000 M BML   

LOADCNS045      

INCWGT ANODWKWY     

WAVE       

WAVE1.00STRE 12.19 81.00 15.00 45.00 D 20.00 18MS10 1 

WIND       

WIND D 45.170 45.00 AP08    

DEAD       

DEAD -Z 81.000 M BML   
 
 
 
 

 



 
 

 
CURR      

CURR 0.000 0.514 45.000  -5.000BC LN 

CURR 81.000 1.801 45.000   

LOADCNS090     

INCWGT ANODWKWY   

WAVE      

WAVE1.00STRE 12.19 81.00 15.00 90.00   D    20.00 18MS10 1 

WIND      

WIND D 45.170  90.00 AP08  

CURR      

CURR 0.000 0.514 90.000  -5.000BC LN 

CURR 81.000 1.801 90.000   

DEAD      

DEAD -Z 81.000 M BML 
 

------------------------------------------------------------------------------------------------------------- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 

载荷工况组合以及后处理校核选项 

 

在SACS中, 载荷工况组合及后处理校核选项可按照如下所示进行定义: 
 

• 定义载荷工况组合: 使用 Load > Combine Load Conditions 命令。  
 

• 选择想要进行校核的载荷工况组合 : 使用Options> Load condition 

selection 命令。  
 

• 设置许用应力修改系数(AMOD): 使用 Options > Allowable stress/Mat 

Factor 命令。  
 

• 添加按UC范围报告结果 (UCPART): 使用 Options > Unity Check Ranges 命

令。  
 

 练习: 定义载荷工况组合和后处理校核选项



提示: 在模型中添加六个载荷工况组合OPR1, OPR2, OPR3, STM1, STM2 和 

STM3。其中三个为正常操作工况，三个为极端风暴工况。 对于工况

组合中的所有环境载荷使用1.1的放大系数， 极端组合工况中的活载

荷使用0.75的载荷系数。



1 选择 Load > Combine load conditions 定义载荷工况组合。操作工况和

极端工况的组合定义如下图所示。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

载荷工况组合命令在datagen中打开后显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

LCOMB 
 

LCOMB OPR1 AREA1.0000EQPT1.0000LIVE1.0000MISC1.0000P0001.1000 
 

LCOMB ORP2 AREA1.0000EQPT1.0000LIVE1.0000MISC1.0000P0451.1000 
 

LCOMB ORP3 AREA1.0000EQPT1.0000LIVE1.0000MISC1.0000P0901.1000 
 

LCOMB STM1 AREA1.0000EQPT1.0000MISC1.0000LIVE0.7500S0001.1000 
 

LCOMB STM2 AREA1.0000EQPT1.0000MISC1.0000LIVE0.7500S0451.1000 
 

LCOMB STM3 AREA1.0000EQPT1.0000MISC1.0000LIVE0.7500S0901.1000 
 

------------------------------------------------------------------------------------------------------------- 
 

2 使用 Options> Load condition selection 选择要进行后处理

校核以及报告的组合工况，如下图所示。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 设置许用应力修改系数(AMOD), 选择 Options > Allowable stress/Mat 

Factor and 然后如下图所示输入相应参数。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

提示: 根据API规范，极端工况下的单元许用应力应该增大1/3, SACS通过

AMOD 命令来定义。 
 
 
 
 
 



 
 

 
 

4 添加按UC范围报告结果的命令(UCPART), 选择 Options > Unity Check 

Ranges 然后输入如下图所示参数。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

定义好的 LCSEL, UCPART 和 AMOD 命令在datagen中显示如下: 
 

------------------------------------------------------------------------------------------------------------- 
 

LCSEL ST    OPR1 ORP2 ORP3 STM1 STM2 STM3 
 

UCPART 0.5000.5001.0001.000300.0 
 

AMOD 
 

AMOD  STM1 1.330STM2 1.330STM3 1.330 
 

------------------------------------------------------------------------------------------------------------- 
 
5    定义后处理分析选项, 选择 Options > Analysis 然后输入如下图所示参

数。 

 
 
 
 
 
 
 
 
 
 
 



 
 
 

 

 
 
 

6 保存文件并命名为 Sacinp.dat_09。 
 
 
 
 
                        至此包含载荷以及分析选项的导管架建模已经完成。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
                                          
 

                                            附录： 结构图纸            


